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Information Management – Setting up an Electronic Recall System 

Part 1 – Recall and Reminder System Overview 
An electronic recall and reminder system allows a medical practice to set up an efficient 
system that notifies patients of the need to make an appointment to see their doctor. 
Most of this is achieved electronically using clinical software. There are, however two 
diverse aspects of the process – the clinical aspect whereby the doctor makes the 
medical decision to recall a patient and the administrative side where the practice staff 
generate recall lists and notify the patient, either by phone or letter. A successful system 
requires a team effort between GPs and Practice Staff so that the clinical and 
administrative functions work correctly. 
 
In order to set up an efficient recall system there are various steps that need to 
happen. 
1. Get the patient database up-to-date by either deceasing or inactivating patients. In 

this way you will not be sending letters to deceased patients or those patients who 
have moved away from your practice. 

 
2. The doctor must know how to mark a patient for recall. This must be done in a 

consistent way – choose from a list of recall reasons rather than typing in your 
own reason. This stops different variations appearing on a recall list, such as: 

 Hep B, hep/b, Hep-B, hepatit B, hepatitis B.  
 
3. As the recall reason appears on a letter to the patient it must be written in a way 

that the patient understands – use Hepatitis A/B rather than Twinrix. 
 
4. The recall reason should also be specific – don’t use the generic “immunisation” 

for adults when the recall is for the specific “Hepatitis B”. 
 
5. The practice must decide on the content of the recall letter. Do you use the 

supplied recall template that comes with your software program, or do you 
compose your own with wording that more closely reflects the philosophy of the 
practice? 

 
Critical decisions to be made when setting up an electronic recall system 
1. How often do you create the recall lists and notify the patients. Daily, every 2 

days, weekly, monthly? 
 
2. What is the interval for the recall (how far ahead)? Weekly, fortnightly, monthly? 
  
3. At what stage do you remove the patient from the recall list? 

 as soon as the patient list is printed? 
 as soon as the mail merge is completed and letters sent? 
 when the doctor sees the patient? 

  
4. Who contacts the patient? Doctor or practice staff? 
 
5. How do you follow up those patients that do not respond to the initial recall. 
 
In most cases it will be a process of trial and error before a practice settles down with a 
process appropriate to their needs. What follows in this book are a few suggestions 
based on over 200 practice visits, from solo practices to large group practices. 
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Part 2 – Cleaning up the database 
“Deceasing” a patient 

Even if you “decease” a patient in your practice management software they also need to 
be deceased in Medical Director (except MD3/Pracsoft 3).  
 
1. Call up the list of patients (press 

<F2> if necessary).  
 

2. Type in the first few letters of 
the deceased’s surname and 
select the name from the list. 
Click on the Delete button (or 
press the Delete key on the 
keyboard). Click on the Mark as 
deceased button. 
 

3. Type in the date of death (if known) and click OK. 
 

To view a deceased patient’s record 
1. MD2 - From the Main menu: Files > Patients > View menu and select Deceased - 

Patients.  
 MD3 - From the Main menu: 

Patient > List… > View menu 
and select Deceased - Patients.  

 
 
2. Highlight the patient whose 

record you wish to view and 
from the File menu select Open. 

 
Removing tutorial patients 

You may have installed the tutorial files when you first installed Medical Director – 
these are the Andersons and the Andrews. There will also be some dummy specialists 
and maybe even Doctor Practitioner. All of these can be removed by using the Remove 
Samples utility program in the Medical Director Maintenance program. 
 
How to do it 
1. Make sure that Medical Director is not running on any computer on the network. 
 
2. Double click on the Maintenance icon on the desktop to open the Medical 

Director Maintenance program 
 
3. Click on the Data Management tab. 
 
4. Click on the Remove Samples button and then follow the onscreen directions to 

remove All Patients and All Specialists. 
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Part 3 – Adding Recalls 
Not only does the GP need to know how to use the clinical software program to invoke a 
recall but s/he must also ensure that recalls are: 

• consistent – where possible choose from a list of recall reasons rather than typing 
in your own reason.  

• written in a language the patient understands 
• specific – don’t use the generic “immunisation” when the recall is for a specific 

immunisation such as “Hepatitis B” 
 
While in a patient’s screen, it is possible to mark that patient for future recall for any 
reason you wish but, for consistency select from the drop down list where possible. 
When you do type in your reason for recall DO NOT use abbreviations. Remember the 
reason for recall will appear on your correspondence with the patient. 
 
In a group practice it will be much more efficient if all GPs of the practice use the same 
recall reasons. 
 
When a patient’s record is opened, the system checks for any recall due within the next 
month. If any are due, a Recall due button and a ringing telephone indicator will appear 
in the top right section of the screen. 
 

Adding a clinical recall 
1. Open one of the patient’s records. 
 
2. From the Clinical menu select Recall 

and the Recall items window is 
displayed. 
 
(Clicking on the Current button will 
display the Recalls for the next 30 
days. 
 
Clicking on the Show all button will 
display all stored recalls). 

 
3. Click on the Add button. 
 
4. From the Recall list, scroll down to 

Weight Review and select it by 
clicking on it once. 

 
5. For the Interval select 1 month. If it is 

a “one off” recall click on the Once 
only recall box. Click on Save. 

 
6. Click on Close when back in the 

Recall items window. 
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7. Once back in the Patient’s medication window you will see a 

ringing telephone with a Recall due button next to it. 
 
8. Click on the Recall due button and the Recall items window will display the 

recalls due in the next 30 days. 
 
9. If you wish to see whether the patient is also marked for any other recalls, even 

though they may not be due yet, click on the Show all button. Click the Current 
button to see only the currently due recall list. 

 
10. If you no longer wish a patient to be marked for recall for a condition, then 

highlight it in the recall list and click on the Remove button. 
 
 The Update button will recalculate the recall interval for an ongoing recall. 

 
11. Click on the Close button to close the Recall item window. 
 
12. On returning to your Progress Notes the recall will have been automatically added 

to the Actions window (unless Progress Notes have been disabled through one of 
the Options choices). 

 
Immunisation recalls 

Both adult and children’s immunisation are linked to the recall system of Medical 
Director. When you invoke a recall, however, the reason for recall is listed as 
IMMUNISATION. In most cases you would want to change this to reflect the specific 
immunisation being given. 
 
Adding an immunisation recall 
1. Open a patient’s record (make sure it is a 

patient over the age of 18) and open the 
Immunisation page by clicking on the 
Immunisation tab. 

 
2. Open the Add Immunisation window by 

either:  
• clicking on the red plus sign in the tool 

bar, or 
• right clicking the mouse and selecting 

New Item, or 
• pressing <F3> 

 
3. From the Type: drop down menu select 

PNEUMOVAX. 
 
4. Type in the Batch No: P 0906 76601 

 (In subsequent pneumovax vaccinations it will default to the last batch number). 
 

Leave the Sequence (1-9) and Comment: boxes empty. 
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5. Click on the Mark for recall button. You will notice that it defaults to the generic 
IMMUNISATION as the reason for recall. In many cases this would be too vague 
to appear in a recall letter. 

 
Type in PNEUMOVAX as Reason for 
recall and set the interval to 5 Years (or 
choose it from the drop down list if it is 
present). 
 
Click on the Save protocol button – this 
will ensure that in subsequent recalls 
PNEUMOVAX will appear in the drop 
down list with an interval of 5 years. 
 

6. Click on the Save button. 
 
7. Once back in the Add Immunisation window click on the Save button. 

© Knowledge Training Page 5 A GP Resource Guide  



Information Management – Setting up an Electronic Recall System 

© Knowledge Training Page 6 A GP Resource Guide  

 
Pap smear recalls 

Routine recalls for pap smear are quite often 
treated separately from other recalls. A practice 
may also use a list of routine pap smear recalls 
generated from a particular pathology 
laboratory. Medical Director allows you to 
enter results and retrieve your own pap smear 
recalls from its own built-in pap smear 
database. 

1.  patient 
and click on the Pap smears tab. 

2. e 
screen and select New item. 

3.  
on the Mark for recall button. 

4. w 

 2-year interval. 
Click on Save. 

 
Adding a pap smear recall 

Open the record of an adult female

 
Right click in the middle of th

 
Fill out the details and then click

 
Once the Add Recall windo
appears (it defaults to PAP 
SMEAR) with a

 
 

Interrog ng
1. 

enu and select 
Pap Smears. 

2. 
s you several options, such 

 

o 

• ith a 
variety of criteria 

3.  2 yrs ago 
and click on Search. 

4. 

 select from the templates. You would have to create your own Pap 
 recall template using LetterWriter (see later section). 

  

ati  the pap smear database 
With no patient record open go 
to the Search m

 
The Pap smears search window 
give
as:
• last smear > 1 yr ago 
• last smear > 2 yrs ag
• no recorded smears 

a custom search w

 
Click on last smear >

 
A list of patients will appear and 
by clicking on the Mail merge 
button you can
Smear
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Where else do I find recalls 
In the above examples you saw that Recalls are generated from: 

 the patient screen – Clinical menu – Recall (Control + R) 
 Immunisation screen 
 Pap Smear screen 

 
Recalls can also be generated from other parts of the program: 

 Health Assessments (patients over 65). Clinical – Health Assessment 
 Pathology results when checking the holding file. Tools – Check Investigation 

Results – View – Mark for Routine Recall 
 Progress Notes – Review – Select Date – Add to recall database 
 Search – Asthma – Recall  
 Search – Diabetes – Add Recall 
 Search – Chicken Pox – Recall (MD2 only) 

 
Mail merge letters can be generated from: 

 Search – Databases (MD3 Search > Patients…) 
 Search – Asthma 
 Search – Immunisations 
 Search – Pap Smears 
 Search – Recalls 
 Search – Chicken Pox ‘At Risk’ (MD2 only) 
 Search – Influenza ‘At Risk’ 
 Search – Pneumovax ‘At Risk’ 
 Files – Outstanding Actions (MD3 Clinical > Outstanding actions) 

 
 
Removing a recall 

During a consultation you may notice the Recall telephone “bouncing” on the screen – 
this simply means a recall is due within the next 30 days. You may be therefore in the 
position to deal with it now. Once the recall has been dealt with you will need to remove 
the recall so that the patient does not get notified of it again. 
 
Exercise – Removing a recall 
1. The patient’s record from the previous exercise should still be open and the Recall 

due button and the ringing telephone should be displayed. 
 
Click on the Recall due button. 
 

2. Click on the Show all button of the Recall items window. 
 
3. Click on Weight Review to highlight it and then click on the Remove button. 

 
4. Click on the Close button. 
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 Part 4 – Contacting Patients 
Overview of recall and actions database 

Medical Director allows you to call up lists of patients that are due for recalls within a 
specified time frame, e.g. all recalls due in the next week, fortnight or month. 
 
These lists of recall patients can be saved, printed, mail merged or printed as labels. If 
mail merged Medical Director provides a number of pre-set letters (templates) that you 
can use to send recall letters to all the patients in the patient lists you have created. You 
can also create your own recall templates. 

 
When you Print, Save, Print labels or Mail merge the list you will be asked whether to 
update the recall list or leave it as it was. By leaving it you allow the doctor to remove 
the recall during the consultation when the patient returns. 
 
When a mail merge is performed, a copy of the letter generated is stored in the patient’s 
correspondence file. 
 
After printing, mail merging or saving the list, all of the recall entries are entered into 
the Actions database.  When a patient’s record is opened, this Actions database is 
checked to see if the patient has any outstanding actions to be taken, and these are 
displayed in an Outstanding actions window.  This window has buttons to allow the 
doctor to either delete the action or mark it as having been performed.  
  
The Outstanding actions list for a patient can be viewed at any time by selecting 
Action list from the Clinical menu. 
 
Note: You must login with at least Basic Access in order to be able to create recall and 
reminder letters that can utilise the Medical Director database of patient information. 
 
 

Creating recall lists 
In the following exercise you print a recall list and then send out a reminder letter for all 
the recalls that are due in the next month. This is an administrative/clinical function and 
is performed when no patient details are displayed. 

 
1. Close any patient record that 

may be showing – from the File 
menu select Close patient (or 
click on the Close this patient’s 
record button). 

 
2. From the Search menu select 

Recalls. 
 
3. In the Select Interval box select 

1 month. 
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4. Click on the Select all reasons checkbox. Click once on any of the highlighted 
recalls (such as PAP SMEAR) you don’t want – this will remove them from the 
recall list box. Then click OK. 

 
5. A list of patients fitting the criteria will be displayed. If you don’t wish to include 

a patient in the printed list click on the patient’s name and then press the delete 
key on the keyboard. 

 
 By clicking Yes you are able to remove the patient from the recall list as well as 

the list on the screen. 
 
6. Click on the Print button at the bottom of the screen – the list generated here can 

be used to cross check with the practice’s appointments and the doctors may wish 
to also check the list for accuracy. The printed list can also be used if the practice 
wants to contact the patients on the recall list  

 
7. Once the list is printed the following 

Update recalls window appears. 
 
 Click on Update and this will 

update any ongoing recalls and 
delete the “once only” recalls. 

 
 Click on Remove and this will 

delete all recalls, even the ongoing 
ones. Only use this option if you are 
“cleaning up” a messy recall 
database. 

 
Click on Cancel so that the recalls remain valid – choose this option if you want 
the doctor to remove the recall during the consultation when the patient returns. 
This means the “ringing” recall button will appear in the patient’s window when a 
recall is due within 30 days. 

 
 
8. Once the list has been checked by the doctors and the appointments you can repeat 

the above procedure, but click on the Mail Merge button at the bottom of the 
screen.  

   
IF IN A TRAINING SESSION STOP HERE!! ONCE THE NEXT STEP IS 
COMPLETED MEDICAL DIRECTOR IMMEDIATELY PRINTS ALL 
LETTERS. 

 

© Knowledge Training Page 9 A GP Resource Guide  



Information Management – Setting up an Electronic Recall System 

9. Click on the Supplied tab and from the list of displayed templates select the 
Recall letter - Standard and click on Open. 

 
 
10. You will be again prompted to 

Update, Remove or Cancel. 
 

By selecting Update or Remove 
the Recalls are moved into the 
Outstanding Actions database. 
 
Selecting Cancel will mean that 
the “ringing telephone” will 
appear on the patient’s screen 
when a recall is due within 30 days. 
 

11. Once printing is complete close the Recall mail merge letter and then close the 
Recall list and Letter Writer to return to the main screen of Medical Director. 

 
 
Checking the outstanding actions 

If a patient does not return for the appointment s/he is left in the Outstanding actions 
database. This is because the doctor has not deleted or marked as performed the 
outstanding action. You should check the outstanding list on a regular basis to ensure 
that patients have been notified of abnormal results (the Return Urgently option when 
checking pathology). The Outstanding actions database also includes the patients who 
have not responded to a recall. You may wish to send them a follow up letter or give 
them a phone call. 

 
 1. With no patient record open go to the Files menu and select Outstanding Actions. 

(MD3 Clinical > Outstanding actions) 
 
2. Check the list and Delete any patients who should not be on the list. 
 
3. Click on the Mark button if the action has been performed. 
 
4.  Click on the Print button to print the list and check with the doctors. 
 
5. Click on the Mail merge button and then choose an appropriate template and print 

the letters. You may have to create a special follow up letter template for this 
purpose. 
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Part 5 – Making appointments and the patient returns 
In the previous section recall lists were 
generated and it is possible to contact 
patients by phone from a printed list or to 
send out a letter advising the patient to 
make an appointment. 
 
The patient makes an appointment and 
now returns. What happens?  
 
 
 

Scenario 1 – the recalls have been removed or updated 
If, after having printed, saved or mail merged a recall list you have the choice of 
Update, Remove or Cancel.  
 
MD2: Update and Remove will add the Urgent recalls to the Outstanding Actions 

database. 
 
MD3: Update will add the Urgent recalls to the Outstanding Actions database. 
 Remove removes the Recall from Recall list but DOES NOT send them to 

Outstanding Actions database. 
 
1. The patient presents for the 

consultation and the doctor and on 
opening the patient’s record an 
Outstanding actions window 
appears showing the doctor very 
clearly if and what recalls need to be 
performed and, if necessary, 
deleted. 

2. e 

t that a recall is due within 30 
days. 

3. nce file the doctor will find copies of the 
call letters that have been sent out. 

g actions can be checked by going to the Clinical menu and 
selecting Action list. 

 
Once in the patient’s record ther
will be no ringing telephone to 
sugges

 
By checking the patient’s corresponde
re
 
A patient’s Outstandin
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Scenario 2 – the recalls have been 
cancelled 

If, after having printed, saved or mail 
merged a recall list you have the choice of 
Update, Remove or Cancel. 
 
By selecting Cancel the recalls are not 
added to the Outstanding actions 
database. 
 
1. The patient presents for the consultation and the doctor opens the patient’s record.  
 
2. An Outstanding actions window may appear from previous recall operations. 

But, because Cancel had been selected after the recall list has been printed or 
merged those recalls are not in the Outstanding actions window. 

 
3. The “bouncing” telephone next to the Recall due button will alert the doctor 

which recall is due. 
 
4. By checking the patient’s correspondence file the doctor will find copies of the 

recall letters that have been sent out. 
 

Which recall system to use? 
The above examples do outline some of the choices that you have. Which system do you 
use? Different practices use different systems. The only way to work it out is to try one 
system and if it works for you then stick with it. If not, change. Whichever way you use 
you will have an initial “bedding down” period before you settle on a system that best 
suits your practice. 
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Part 6 – Customised Recalls 
In the following example you will send out a letter to all your patients between 45-49, 
reminding them that they should make an appointment for a 45 -49 health check (item 
717). A template for this is available on the NEVDGP website. 
 

Exercise – Customised recall  
1. Make sure that there is no patient record open. 
 
2. MD2: From the Search menu select Databases – you may get a message stating 

that the process could be slow from a work station. Click Yes to continue. 
 MD3: From the Search menu select Patient… – you may get a message stating 

that the process could be slow from a work station. Click Yes to continue. 
 
3. Set the following selection criteria, as shown: 

• Age greater than or equal to: 45 
• Age greater than or equal to: 49 
• Sex: All 

 

4. Click on the Search button.  
 
5. A list of patients fitting the criteria (patients between 45-49) will appear. 
 
6. Click on the Mail Merge button for this window to appear. 
 

IN A TRAINING SESSION STOP HERE!! ONCE THE NEXT STEP IS 
COMPLETED MEDICAL DIRECTOR IMMEDIATELY PRINTS ALL 
LETTERS. 

 
7. From the list of displayed templates select the 45 - 49 year old Health Check letter 

and click on Open. 
 
Additional Exercises 
1.  Use the Clinical/ Databases to create a list of patients that have had Daonil 

prescribed. 
 
2. Create a list of all female patients between the ages of 15 to 75. 
 

“At risk” influenza vaccine search tool 
This tool generates a list of patients meeting the NH&MRC criteria for influenza 
vaccination. The search can be performed for either all patients over the age of 65, or for 
patients under 65 who would benefit from Influenza vaccination.It may be used as a 
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substitute for the Clinical/Databases function which allows you to generate a list of the 
over 65 year olds for the annual Influenza vaccination. 
 
The advantage of the “at risk” tool is that the list generated will exclude any patients: 

 who have been marked as allergic to Influenza vaccine 
 who have previously been marked as not for Influenza vaccine prompts in the 

Preventive Health screen 
 who have had an Influenza vaccination recorded on their immunisation tab this 

calendar year. 
 
Once the list has been generated, it can be saved, printed or used for a mail merge in the 
same way that other search results can be used.  
 
Exercise 1 – Creating the over 65 “at risk” list 
1. With no patient record open go to the Search menu and select Influenza ‘At risk’  
 
2. The default setting is for the 

over 65 year olds (50 years 
ATSI). 

 
3. Click on the Search button 

and this will generate a list 
of patients who fit the criteria. 

 
 READ THE FOLLOWING DIRECTIONS BUT DO NOT COMPLETE THE 

FOLLOWING STEPS AS MULTIPLE SCRIPTS AND FLUVAX REMINDER 
LETTERS ARE GENERATED.  

 
4. Click on the Print Scripts button at the bottom left of the window – when this 

button is clicked, a window allows you to select from the available Influenza 
vaccine brands. You are then able to print a prescription for every patient on the 
list. 

 
5. Click on the Mail Merge button at the bottom of the window – you are taken to 

the Select Mail Merge Template window. 
 
6. Click on the Supplied templates. 
 
 Choose the Recall LETTER – Flu + 

Script template if including a script with 
the reminder letter, 
OR  
Choose the Recall Letter – Flu Std template if no scripts are to be included. 

 
Pneumovax ‘At Risk’ and Chicken Pox ‘At Risk’ 

These 2 “at risk” searches work in a very similar way to the Influenza ‘At Risk’ search. 
1. Generate the patient list using the Search/…’At Risk’  
 
2. There is a recall letter for both Pneumovax and Chickenpox (MD2 only) in the 

Supplied templates when you select Mail merge. 
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Part 7 – Organising and Cleaning Up Recalls 
As a practice you will need to have a meeting of all GPs and the Practice Manager to: 

• clean up existing recalls  
• set up the recall protocols 

 
Cleaning up the recalls 

The doctor or doctors of a practice may 
have started using the recall system but 
used: 

• different names for the same 
recall  

• abbreviations for recalls 
• non-specific names 

 
The example opposite shows you the 
inconsistencies with hepatitis A and B. 
Ideally you would want only 
HEPATITIS A and HEPATITIS B to 
appear in the list.  
 

Deleting unnecessary recalls 
1. With no patient record open from 

the Search menu select Recalls. 
Under Select reasons you will see 
listed all the Recall reasons that the 
doctors of the practice have 
entered for their pa
 
You cannot delete the recall 
reasons from here. 

tients.  

 
2. To check on individual doctor’s 

recalls select the Interval as All, 
Click on the doctor’s name under 
Select Doctor and click in the 
Select all reasons box. 

 
3. Once you click OK all the recalls 

for that particular doctor will be 
displayed. 
 
It may be worthwhile to print the 
list and manually check with the 
appointments system. 

 
4. To delete the recalls click on the 

unwanted recall to highlight it, then 
press the delete key on the keyboard. 
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Deleting recall reasons 

The above exercise displayed all the recalls that have been invoked by the doctors of the 
practice. You may now wish to delete some of the recall reasons. 
 
1. Open any patient’s record .and from 

the Clinical menu select Recall (or 
press Control + R). 

 
2. Once the Recall items window 

opens, click on the Add button. 
 
3. The Add Recall window now 

opens.  
MD2: Click once on the unwanted 
recall reason and press the delete key on the keyboard.  
MD3: Hold the mouse pointer on the unwanted recall reason (hold down mouse 
button) and press the Delete key on the keyboard. 
 

4. Continue the process until all unwanted recall reasons are deleted.  
 

Setting up recall protocols 
Once you have deleted the unwanted recall reasons as in the exercise above you would 
now want to add those recall items that you want to appear in the list. To do this you set 
up your own recall protocols. The recall protocol is  

• the name (or reason) of the recall 
• the interval, or time when the recall is due 
• whether its are a “once only” or an “ongoing” recall. 

 
Adding recall reasons 

1. Open any patient’s record. 
 
2. From the Clinical menu select 

Recall (or press Control + R in 
MD2 or <F4> in MD 3). 

 
3. Once the Recall items window 

opens, click on the Add button. 
 
4. The Add Recall window now 

opens. 
 
5. Type in the reason for recall (such 

as MEN’S HEALTH REVIEW. 
 
Make the Interval 1 Year and leave the Once only recall box unchecked. 

 

© Knowledge Training Page 16 A GP Resource Guide  



Information Management – Setting up an Electronic Recall System 

6. Click on the Save Protocol button – this will make this recall reason available for 
all patients. DO NOT click on the Save button as this would add a recall for the 
patient whose record you presently have open. 

 
7. Add other recall reasons as appropriate, remembering to click on the Save 

protocol button after each new recall reason. 
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Adding the date to the Recall printout 

When you generate a list of Recall patients (Search/Recall) the date of the recall appears 
on the screen. When you print the list the date of the recall does not appear on the 
printed list. 
 
You can, however change this. 
1. From the Tools menu (Main menu or patient screen) select Print Options and 

then click on the Recall Sheet tab. 
 
2. Click in the last box on the Recall 

due date – this will place an arrow 
in the box. 

 
3. Add the width value of 20 (20mm). 

You will need to reduce the width 
of some of the other fields to 
compensate for this. 

 
 For example reduce both the Name 

and Address by 10mm each. 
 
 The values should be similar to 

what is illustrated below. 
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Part 8 – Setting up Recall Templates 
Overview of templates 

Templates are pre-formatted letters that can be set up with your own layout and content 
and saved for repeated use. Medical Director has its own set of built-in templates, which 
you can use immediately (called Supplied templates).  
 
You can modify the Supplied templates to better suit your practice, or templates can also 
be created from scratch. Any template you modify or create from scratch are called User 
Defined templates. A template can be saved so that all users can access it or be used 
only by the creator of the template. 
  
 

Supplied recall templates 
Medical Director comes with many supplied recall templates. 

 
The Recall Letter – Standard template can be used with a general clinical recall. The 
example on the left is the template showing the fields. The example on the right is how a 
mail merge fills in the specific details of a particular patient. 

<<Miscellaneous:Practice Letterhead>> 
 
 

<<Doctor:Name>> 
<<Doctor:Qualifications>> 

<<Doctor:Provider Number>> 
 
 

<<Miscellaneous:Date>> 
 
 
 
 
<<Patient Demographics:Title>> <<Patient 
Demographics:First Name>> <<Patient 
Demographics:Surname>>, 
<<Patient Demographics:Address>>, 
<<Patient Demographics:City>>. <<Patient 
Demographics:Postcode>>. 
 
 
Dear <<Patient Demographics:Greeting>> 
 
Our records show that you are due for recall for the 
following reason: 
<<Mail Merge:Recall Reason>> 
 
Could you please ring this surgery to arrange an 
appointment. 
 
 
Yours sincerely, 
 
 
   <<Doctor:Name>> 

Park Street Clinic 
 

Dr. A. Practitioner 
M.B.,B.S., Dip R.A.C.O.G. 

610234a 
 
 

17th July 2001 
 
 
 
 
Mr David Anderson, 
61 Wallace St., 
Melbourne. 3000. 
 
 
 
 
Dear David 
 
Our records show that you are due for recall for the 
following reason: 
Weight review. 
 
Could you please ring this surgery to arrange an 
appointment. 
 
 
Yours sincerely, 
 
 
 
   Dr. A. Practitioner 
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User defined templates 

Under User Defined you will find the templates that you have used in previous versions 
of Medical Director or ones that you have created or modified yourself. 

To view existing User Defined templates 
1. Make sure a patient’s record is open and click on the LetterWriter button. 
 
2. From the File menu select New. 
 
3. The list of User Defined templates is displayed. 

 
 

Modifying templates 
You may wish to make some changes to an existing template to improve the layout 
and/or reflect your particular practice. You can do this from either the User Defined or 
Supplied templates.  
 
Rather than creating a template from scratch it is a better idea to modify an existing 
template and save the changes with a different file name.  
 
The way to create a modified template in Medical Director is a 3-step process: 
1. From the File menu of LetterWriter select Modify Template. 
2. Make the changes. 
3. From the File menu select Save as Template and select the template to be available 

for either: All Users or Current User. 
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Modifying the “Recall Letter – Standard” 
template 

1. With a patient’s record open, click on the LetterWriter button. 
 
2. From the File menu select Modify Template. 
 
3.  Click on the Supplied tab and select Recall Letter – Standard. 

 
4. Make the following modifications: 

 delete the excessive space between the date and the patient demographics 
 delete the excessive space between the patient demographics and the 

salutation 
 highlight <<Mail Merge:Recall Reason>> and make it bold 
 remove the comma after Yours sincerely 
 insert the cursor before <<Doctor:Name>> and press the Backspace key 3 

times so it is aligned to the left margin 
 add text where necessary to make it more in the style of your practice. 

 
5. From the File menu select 

Save as Template. 
 
6. When the Save template 

window appears type in an 
appropriate name. eg. Noel’s 
recall 

 
7. From under User Access 

select: 
• All Users if you want the 

template to be made available for all doctors of the practice,  
  OR 

• Current User if you want the template to be only available for the creator of 
the template.  

 
8. Click on the Save button. 
 
9. From the LetterWriter 

File menu select New 
and you will see that 
your new template is 
included in the list. 

 
In the New dialogue box 
under Filter you will see 
that you can switch 
between All Users and 
Current User.  

© Knowledge Training Page 21 A GP Resource Guide  



Information Management – Setting up an Electronic Recall System 

 
Creating a template from scratch 

1. With a patient’s record open click on the 
LetterWriter button. 

 
2. From the File menu select New and then double-

click the Blank Template icon. A Template 
Fields toolbar containing a list of template fields 
will open on the right hand side of the window. 
Whenever the Template Fields toolbar is present 
the LetterWriter is in template editing mode.  

 
3. The toolbar can be hidden by clicking the Hide 

Window button. To show it again click on the 
Show Window button. 

 
4. Click on the + sign next to Miscellaneous and then click on Practice Letterhead. 

Click on the Insert Field button. 
 
5. Press Enter twice and then select Date and click on the Insert Field button. 
 
6. Press Enter twice and add the following FIELDS and text – make sure there is a 

space after Dear and between each field. 
 

7. Once the letter is complete go to the File menu and select Save as Template. 

<<Miscellaneous:Practice Letterhead>> 
 
<<Miscellaneous:Date>> 
 
<<Patient Demographics:Full Name>> 
<<Patient Demographics:Full Address>> 
 
Dear << Patient Demographics:Greeting>>, 
 
The Park Street Clinic operates a computerized Preventative Medicine Program and Patient 
Reminder System for follow up or review of relevant important medical issues concerning the 
individual, for example: general medicine, skin checks, blood pressure, cholesterol, men’s and 
women’s health, immunisation, depression. 
 
Your name has presented on the recall/reminder list for: 
<<Mail Merge:Recall Reason>> 
 
You are invited to ring the surgery on <<Practice:Phone>> and make an appointment at your 
earliest convenience. 
 
Should you require any further information, please do not hesitate to speak with me prior to making 
the appointment 
 
Yours faithfully 
 
 
Sister Patricia Marshall  
Office Manager 
Park Street Clinic 
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8. In the Save template window type in an appropriate file name, such as NOEL’S 

PHYSIO REF and then click on the Save button. 
 
9. From the File menu of LetterWriter select New and then select your Physio 

referral from the list.  
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Setting up a men’s health recall 

1. Set up a template for a Men’s Health recall, as illustrated below. 
 

 

<<Miscellaneous:Practice Letterhead>> 
<<Doctor:Name>> 
<<Doctor:Qualifications>> 
<<Doctor:Provider Number>> 
 
<<Miscellaneous:Date>> 
 
<<Patient Demographics:Title>> <<Patient Demographics:First Name>> <<Patient 
Demographics:Surname>> 
<<Patient Demographics:Address>> 
<<Patient Demographics:City>>  <<Patient Demographics:Postcode>> 
 
 

Dear <<Patient Demographics:Greeting>>, 
 
It is now widely recognised that early diagnosis and/or treatment of many diseases has the 
potential to reduce or eliminate the impact of that disease. In some cases simple lifestyle 
changes can prevent the onset of disease. The Park Street Medical Centre has introduced a 
new service that offers men over the age of 40 a comprehensive review of their health, 
including lifestyle risk factors. The new service is a “Men’s Health Check” that will review 
your current health status and assess your risk of developing illnesses. Please see enclosed 
flyer for more information. 
 
The service will also be a longer than usual consultation (about 45mins), so please remember 
to notify the Receptionist that you will need an extended consultation on booking the 
appointment. 
 
The service will cost <XX> of which you will be able to claim <XX> from Medicare. 
 
After completing the assessment we will have a clearer understanding of your future health 
needs and will be able to plan appropriately.  
 
Yours sincerely, 
 
 
Dr Practitioner 

2. With no patient record open go to the Search menu and select Databases. 
 
3. Select age greater than 35 and less or equal to 49. For sex click on Male. Then 

click on the Search button.  

 
The next time you would choose the 50-75 male age group.  
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Setting up a reminder for a Health Assessment 
for the over 75s 

1. Set up a template for a Health Assessment letter, as illustrated below. Save it as 
75+ Health Assessment. 

2. With no patient record open go to the Search menu and select Databases 

<<Miscellaneous:Practice Letterhead>> 
<<Doctor:Name>> 
<<Doctor:Qualifications>> 
<<Doctor:Provider Number>> 
 
<<Miscellaneous:Date>> 
 
<<Patient Demographics:Title>> <<Patient Demographics:First Name>> <<Patient 
Demographics:Surname>> 
<<Patient Demographics:Address>> 
<<Patient Demographics:City>>  <<Patient Demographics:Postcode>> 
 

Dear <<Patient Demographics:Greeting>>, 
 
You may have read in the newspaper that as part of the Federal Governments initiatives to 
improve the health care available to older Australians, the Medical Benefits Schedule has 
introduced new Item Numbers for Health Assessments for patients over 75 years of age. 
 
As your GP, I would like to offer you this service. There is no cost as it is reimbursed by 
Medicare. You will simply be asked to sign a payment voucher following the completion of 
the assessment. 
 
A Health Assessment is really a detailed look at such things as your general health, including 
sight, hearing, diet, sleep and any medication you might be taking. It also includes any help 
you may be receiving at home (eg home help, meals on wheels) your immunisation status; 
and, if you have any problems with shopping, dressing or bathing etc. 
 
The Health Assessment is not compulsory but I believe that it may help us identify any 
health needs you may have. An early intervention will allow you to enjoy better health for 
longer. 
 
I would encourage you for these reasons to contact the surgery to make an appointment for 
such an assessment. 
 
If you have any concerns about this letter please contact me at the surgery to discuss them 
 
Yours sincerely 
 
Dr Practitioner 

 
3. Select age greater than 75 for all patients. Then click on the Search button.  

4. When the list appears click on the Mail Merge button at the bottom of the screen. 
 
5. Select the 75+ Health Assessment template.
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1 

Adding a recall 
1. In patient record Clinical/Recall (or Control 

+R). 
2. Click on Add. 
3. Select Reason for recall from list, or type in 

recall reason. 
4. Select Interval. 
5. Click in box next to Once only recall. 
6. Click on Save and then Close. 
 
 
 

2 

Creating recall list and contacting patients (eg once per month) 
1. No patient record open – Search/Recalls. 
2. Select  Interval – 1 month 
   Select Doctor – ALL 
   Select all reasons 
3. Click OK. 
4. Highlight and press Delete key to remove any 

unwanted recalls. 
5 Print Recall list (if necessary) to check validity 

with doctors. Click on Cancel (Not UPDATE 
or REMOVE) 

6 Click on Save to save list. Click on Save again. 
Click on Cancel (Not UPDATE or REMOVE). 

7 Click on Mailmerge. 
8. Select Recall letter – standard – this will print 

all the letters. 
9. Click on Update (or Remove), then Close. 
10. Post out letters and make appointments when patient rings. 
 
 

3 

Patient returns to see doctor 
1. Open patient record. 
2. When Outstanding Actions appears – click on Mark as performed. 
3.  Continue with consultation. 
 
 

4 

Check outstanding actions (weekly) 
1. No patient record open – File 

menu/Outstanding actions. 
2. Click on Print to create list of patients. 
3. Check the list 

- contact patient if necessary (phone or letter) 
- click on Mark if action has been performed 
 - click on Delete if no longer valid 

4. Close 
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Medical Director – Recall Flowchart Mailmerge 

Outstanding 
Actions with 

follow-up Recall 
letter 
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Staff generate 
Recall list 
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list 

Save Recall list 
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list with Recall 

letter
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Check 
Outstanding 

Actions 

Outstanding 
Actions – Mark as 

performed 

Printed Urgent and Discuss lists get 
transferred to Outstanding Actions 

Investigations 

If No-show 

Cancel

Cancel

Recall remains 
unchanged Cancel 
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